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Abstract

Using electrostatic simulations, a transmon qubit with new shape and a large geometrical
size was designed. The coherence time of the qubits was increased by a factor of 3-4 to
about 4 µs. Additionally, a new formula for calculating the coupling strength of the qubit
to a transmission line resonator was obtained, allowing reasonably accurate tuning of qubit
parameters prior to production using electrostatic simulations.
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1 Introduction

In the past decades, scientists have developed growing interest in experimental realizations of
quantum information processing. The development of a computer consisting of quantum bits
(qubits), which possess an infinite number of continuous superposition states in contrast to a
classical bit with only two states, could lead to a tremendous increase in computational power
for certain problems [1].

A promising type of qubit for the realization of a quantum computer is the transmon [2],
which consists of two superconducting islands connected by Josephson junctions. This type of
qubit can be fabricated reliably using modern lithography techniques, which are well-established
fabrication methods, allowing to specifically design some properties of the qubit. In particular,
such qubits have a macroscopic size, leading to a dipole moment which is larger by orders of
magnitude than the dipole moment of e.g. atoms, allowing strong coupling to electric fields for
qubit manipulation and transport of information from one qubit to another using photons.

Unfortunately, the possibilities of transmon manipulation are currently limited by their
relaxation time (T1) and dephasing time (T2). In this semester project, a new transmon design
with an increased overall size was introduced, leading to an increase of the relaxation time by a
factor of 3-4. Initially, simulations for the important qubit parameters EC and g were validated
using existing qubit designs. As a second step, qubits with an intermediate size were designed,
leading to an increase in coherence time already. Finally, a new deisgn of large transmons was
introduced, but the coherence time remained roughly the same as with the intermediate size.
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Figure 2.1: a) Top view of a simple coplanar waveguide resonator. b) Cross section of a CPW. Note
that the dimensions are not to scale.

2 Theory

In this section, the fundamental theory underlying the operation of transmon qubits will be
introduced, closely following ref. [3] unless mentioned otherwise.

2.1 Coplanar waveguide resonator

A 1D coplanar waveguide resonator (CPW), shown in Fig. 2.1, consists of a center conduction
line separated from coplanar ground planes by a gap. Input and output transmission lines are
coupled capacitively to the resonator line. The conductors consist of thin layers of conducting
material mounted on an isolating substrate in a photo-lithographic process.
The fundamental mode of a CPW of length l is given by the standing wave resonance condition
at a wavelength λ = 2l. This is the relevant mode for the interaction between the resonator
and the qubit if the qubit is placed at an end of the resonator.

2.1.1 Quantum mechanical treatment

A superconducting CPW resonator can be modeled by a simple parallel LC oscillator (induc-
tance Lr, capacitance Cr) carrying a current I(t) and a voltage drop v(t). According to ref.
[4], a Hamiltonian formulation of a circuit requires the flux Φ(t) =

∫ t
−∞ v(t′)dt′ and the charge

Q(t) =
∫ t
−∞ I(t′)dt′. Replacing these quantities by their corresponding quantum mechanical

operators φ and q, obeying the commutation relations [φ, q] = i~, the quantum mechanical
Hamiltonian of the system can be written as

Hres =
q2

2Cr
+

φ2

2Lr
= ~ωr

(
a†a+

1

2

)
, (2.1)

with the angular resonance frequency ωr = 1/
√
LrCr, the characteristic impedance Z =

√
Lr/Cr

and a = 1√
2~Z

(φ+ iZq) obeying [a, a†] = 1.

2.2 Superconducting qubits

In contrast to a classical bit, which can only assume two values 0 or 1, a qubit (quantum bit)
is a quantum mechanical system described by a two-dimensional Hilbert space with two basis
states |0〉 and |1〉, i.e. it can assume a continuum of states |Ψ〉 = α|0〉+β|1〉 with |α|2 + |β|2 = 1.
Superconducting qubits have a large number of eigenstates, so in order to induce transitions
between two states only, the energy spectrum of the qubit needs to be sufficiently anharmonic.
Typically, the ground state |g〉 and the first excited state |e〉 of the qubit will be the states
of choice, since the ground state can be initialized reliably if kBT � Ee − Eg = hνge. To
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Figure 2.2: Schematic drawing of a Cooper pair box qubit. A superconducting island is connected to
a superconducting reservoir by a Josephson tunnel junction with capacitance CJ (typical value: 6 fF).
An external gate Voltage Vg is applied between the superconductors via a capacitance Cg, inducing
a charge difference CgVg. A charge imbalance between the superconductors results depending on Vg,
because charge can only tunnel across the junction in units of Cooper pairs.

perform operations on the qubit, these states need to be sufficiently long-lived compared to the
manipulation time.

2.2.1 Cooper pair box

The Cooper pair box (CPB) was the first qubit based on superconducting circuits [5, 6]. It
consists of a superconducting island connected to a superconducting reservoir by a Josephson
tunnel junction, as shown in Fig. 2.2. The Josephson junction consists of two superconductors
connected by a very thin layer (on the order of 1 nm) of insulating material, allowing Cooper
pairs to tunnel between the superconductors without transmission of quasiparticles [7].
The Hamiltonian of the CPB is given as [2]

Hqb = 4EC(n̂− ng)2 − EJ cos ϕ̂. (2.2)

ng = Qr/2e + CgVg/2e is the induced charge difference (offset charge), where Qr is some
environment-induced charge difference and CgVg is the induced charge difference due to the
external voltage as defined in Fig. 2.2. n̂ denotes the number of Cooper pairs transferred
between the islands and ϕ̂ is the gauge-invariant phase difference between the superconductors.
Note that both n̂ and ng are measured in units of 2e (Cooper pairs).

EC =
e2

2CΣ
(2.3)

is the charging energy required to put an additional electron on the island, where CΣ is the
total capacitance between the superconductors. The Josephson energy EJ is the coupling energy
associated with the tunneling of one electron across the junction. To illustrate this in a different
notation, the Hamiltonian can also be written in the basis of eigenstates |n〉 of the Cooper pair
number operator, i.e. n̂|n〉 = n|n〉, as used in ref. [6]:

Hqb = 4EC

∑
n

(n− ng)2|n〉〈n| − EJ

∑
n

(|n〉〈n+ 1|+ |n+ 1〉〈n|) . (2.4)

Moreover, this form of the Hamiltonian can approximately be solved numerically by diagonal-
ization if a truncated basis of 2N + 1 states |n〉, n = −N, ..., N is used.

For a simple CPB, as shown schematically in Fig. 2.2, the Josephson energy EJ is a constant,
determined by design parameters and material properties of the Josephson junction. However,
by designing a qubit with a split junction, i.e. two spatially separated junctions forming a
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Figure 2.3: left: Effective circuit diagram of the transmon qubit. The island and the reservoir are
coupled via an additional effective capacitance CB , increasing the total capacitance CΣ = CB +CJ +Cg

between the superconductors w.r.t. the CPB. φ denotes the magnetic flux through the split junction
loop. right: schematic of a simple transmon design.

superconducting loop, the Josephson energy EJ can be tuned by applying an external magnetic
field inducing a magnetic flux φ through the loop:

EJ(φ) = EJmax

∣∣∣∣cos

(
πφ

φ0

)∣∣∣∣ , (2.5)

where φ0 is the magnetic flux quantum and EJmax a constant, depending again on the fabrication
parameters of the junctions.

2.2.2 Transmon

The transmon (transmission-line shunted plasma oscillation qubit) is an advanced qubit design
based on the Cooper pair box. In contrast to the CPB, the island and the reservoir are capaci-
tively coupled to each other with a much larger additional (effective) capacitance CB than the
junction capacitance CJ , increasing CΣ and therefore reducing EC . The effective capacitance
network of the transmon network is shown in Fig. 2.3. Analogous to the CPB, the external gate
voltage Vg could in principle be used to control the offset charge ng = Qr/2e+ CgVg/2e of the
transmon qubit.

The main advantage of the transmon compared to the simple CPB is the much higher
ratio EJ/EC . An increase of EJ/EC leads to an exponential decrease of the charge dispersion
(dependence of the eigenenergies on ng), while the anharmonicity of the energy levels decreases
with a weak power law only [2]. The first three energy levels of the transmon are shown in
Fig. 2.4 as a function of ng for different ratios EJ/EC .
In the limit EJ/EC � 1, the transmon Hamiltonian can be solved approximately using

perturbation theory [2], leading to an analytical approximation for the energy Em of state m:

Em ≈ −EJ +
√

8ECEJ

(
m+

1

2

)
− EC

12
(6m2 + 6m+ 3). (2.6)

The resulting absolute anharmonicity is −EC . In short, the transmon design strongly reduces
the sensitivity to charge noise (i.e. changes in ng), while preserving an anharmonic energy level
spectrum needed for state control.
The transition frequency from the ground state to the first excited state is given as

νge ≈
√

8EJEC − EC

h
. (2.7)
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Figure 2.4: The charge dispersion of the first three eigenstates of the transmon Hamiltonian for different
ratios EJ/EC . Energies are given in units of EC and the zero point of energy is chosen as the minimum
of the lowest state. EJ/EC = 0 corresponds to unperturbed pure charge eigenstates with a parabolic
dispersion. In the limit EJ � EC , the eigenenergies become independent of ng. The energies were
calculated in Matlab using Eq. (2.4) and a truncated basis of 201 basis states (N = 100).
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2.3 Resonator-qubit coupling (Jaynes-Cummings model)

The interaction of a transmon and a CPW resonator can be described by the Jaynes-Cummings
model. In order to write down the coupled Hamiltonian, it is useful to rewrite the transmon
Hamiltonian (2.2) in the basis of the uncoupled transmon eigenstates |i〉:

Hqb = ~
∑
i

ωi|i〉〈i|, (2.8)

where ~ωi is the energy of state |i〉. Combining this expression with the Hamiltonian of the
resonator (2.1) and omitting the zero point energy of the resonator, the generalized Jaynes-
Cummings Hamiltonian for the coupling of the transmon to the resonator is obtained as [2]:

H = ~
∑
i

ωi|i〉〈i|+ ~ωra
†a+ ~

∑
i,j

gij |i〉〈j|(a+ a†), (2.9)

with coupling energies

~gij = 2eβ

√
~ωr

2Cr
〈i|n|j〉 = ~g∗ji (2.10)

and
β :=

Cg

CΣ
. (2.11)

For large ratios EJ/EC , the matrix element 〈i|n|j〉 leads to a relevant contribution for nearest-
neighbour coupling only (j = i±1). The rotating wave approximation can be used to eliminate
the terms in Eq. (2.9) describing simultaneous excitation/deexcitation of the qubit and the
resonator, leading to the effective generalized Jaynes-Cummings Hamiltonian [2]:

H = ~
∑
i

ωi|i〉〈i|+ ~ωra
†a+

(
~
∑
i

gi,i+1|i〉〈i+ 1|a† + h.c.

)
, (2.12)

with

gi,i+1 ≈
2e

~
β

√
~ωr

2Cr

√
i+ 1

2

(
EJ

8EC

)1/4

(2.13)

and Cr = π/(2ωrZ0), Z0 = 50Ω [3].
For the excitation of the qubit from the ground state to the first excited state (i.e. i = 0), the
coupling becomes

g := g01 ≈
√

2e

~
β

√
~ωr

Cr

(
EJ

8EC

)1/4

, (2.14)

which will be called g from now on.

2.4 Effective transmon network

An effective circuit diagram of the transmon network was shown in Fig. 2.3. The purpose of
this section is to derive the effective capacitances Cg and CB for a qubit coupled to a single
resonator. Figure 2.5 shows the real capacitance network of the transmon and again the effective
network. In order to calculate EC and g, both CΣ = Cg + CB + CJ and β = Cg/CΣ are needed,
which can be obtained by solving a linear system of equations which is found by making use of
Kirchhoff’s laws.
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Figure 2.5: left: real capacitance network of a transmon coupled to a CPW resonator, consisting of
four superconductors, i.e. ground plane (1), reservoir (2), island (3) and resonator (4). right: effective
network of the transmon as described in section 2.2.2. Note that CB can be split into CB = C ′

B + C23.

2.4.1 Calculation of CΣ

CΣ is the total capacitance across the junction (between the island and the reservoir) and
consists of four (effective) capacitances in parallel: CΣ = Cg + C ′B + C23 + CJ , as can be seen
in Fig. 2.5. CJ and C23 are directly determined by the transmon design, so the task is reduced
to calculating Cg + C ′B =: C0. This can be accomplished by replacing C23 and CJ in the real
capacitance network by a voltage source V and calculating the total capacitance C0 of the
resulting circuit (with Vg removed). From Kirchhoff’s laws, we obtain the set of equations

V = V24 + V34

V = V12 + V13

V = V12 + V14 + V34

0 = −Q12 −Q14 +Q13

0 = Q14 −Q24 +Q34,

which can be solved for the quantities {V, V12, V13, V24, V34}. Using Qij = VijCij and the ex-
pression for the total charge

Q = Q12 +Q24 = Q13 +Q34 =
1

2
(Q12 +Q24 +Q13 +Q34),

the capacitance C0 is obtained as

C0 =
Q

V
=

(C12 + C24)(C13 + C34)

C12 + C13 + C24 + C34
,

where the limit C14 →∞ has been taken, since the capacitance C14 between the resonator and
the ground plane is much larger than all other capacitances (due to the much larger dimensions).
Finally, CΣ is obtained as

CΣ =
(C12 + C24)(C13 + C34)

C12 + C13 + C24 + C34
+ C23 + CJ . (2.15)

2.4.2 Calculation of β

The splitting parameter β describes the share of the voltage drop V23 across the junction if a
gate voltage Vg is applied between ground and resonator, as in Fig. 2.5. This can easily be seen
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by defining the effective shunting capacitance CS := CB + CJ . The share of the voltage drop
across the junction is then given by

V23

Vg
=

1
CS

1
CS

+ 1
Cg

=
Cg

Cg + CS
=
Cg

CΣ
= β, (2.16)

which coincides with the definition given in Eq. (2.11). β is then obtained by using Kirchhoff’s
laws and solving the set of equations for the individual voltage drops. The limit C14 →∞ is
not needed, because β does not depend on C14. The final result is

β =
C12C34 − C13C24

(C12 + C24)(C13 + C34) + (C12 + C13 + C24 + C34)(C23 + CJ)
. (2.17)

The detailed calculation (including the calculation of CΣ) can be found in the file
”Q:\USERS\SimonBur\Mathematica\capacitance_1res.nb”

2.4.3 Qubits coupled to 2 resonators

The procedure described above can easily be generalized to a qubit with two resonators, resulting
in a larger equation system. Additionally, the capacitances between the ground plane and the
resonators also have to be set to infinity in the calculation of β1 and β2. Unfortunately, the
resulting expressions for EC , g1 and g2 get too cumbersome to fit in this report in a legible way,
so they are not included, but the Mathematica file containing the calculation can be found at
”Q:\USERS\SimonBur\Mathematica\capacitance_2res.nb”.

2.4.4 Charge line and flux line couplings

As will be seen later, an actual qubit needs couplings to other electrodes for manipulation.
However, these couplings are much smaller than those between island, reservoir, resonator and
ground plane. Therefore, they were neglected in the calculation of CΣ and β.

2.5 Transmon relaxation time (T1)

As mentioned previously, the relaxation time T1 of the excited transmon state should be long
enough to perform qubit operations. A range of different processes can lead to relaxation and
therefore limit T1 [2]. It has been shown that dielectric loss from insulating materials can be a
dominant source of decoherence, depending on the qubit design [8]. However, the microscopic
nature of this dielectric loss is not well understood, although there are indications that the
dissipation might be due to coupling to two-level fluctuators in surface impurities [9]. Ref.
[10] states that for CPW resonators, the dominant contribution to the dielectric loss arises due
to surface impurities in the metal-substrate and substrate-air interfaces. Therefore, reducing
the electric field produced by the qubit in these surface regions seems a promising strategy for
increasing T1. This was the main goal of this semester project.
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3 Transmon simulation

Previous qubits used for measurements in our group had energy relaxation times on the order of
T1 ∼ 1 µs [11], when ref. [12] reported qubits with relaxation times on the order of T1 ∼ 10 µs.
An obvious difference to our design was an increase in the overall qubit size, as illustrated in
Fig. 3.1. For future experiments in our group, the charging energy EC/h of the qubits should
ideally be in a range 300− 350 MHz and the coupling g/h between 300− 400 MHz. So the
idea was to modify the design of our qubits and see if we can get similar relaxation times, while
keeping the parameters Ec and g in a similar range as before. Parallel to the beginning of
this semester project, a newer transmon design had been fabricated in our group, resulting in
relaxation times on the order of 4 µs, but with considerably lower g on the order of 100 MHz
(shown in Fig. 3.3). An overview of the properties of the different qubits is given in table A.1.
For all qubit simulations, the junction capacitance was assumed to be CJ = 6 fF, based on
experience from previous experiments.

3.1 Ansoft Maxwell

Since the process of qubit fabrication, installation of the qubit into an experimental setup and
measurement of the qubit parameters takes a long time (typically several weeks), it is not
possible to just design a large set of different qubits and measure their properties in order to
optimize the design. Instead, some properties of qubits can be simulated on computers. In
this work, the commercial software Ansoft Maxwell (version 14) was used. For a user-defined
qubit design, Maxwell numerically solves Maxwell’s equations using the iterative finite elements
method. The user can define a maximum number of passes or set convergence thresholds for
the simulation to end. Depending on the specific solution type chosen by the user, Maxwell can
calculate the mutual capacitance matrix (electrostatic solution) or the mutual inductance ma-
trix (magnetostatic solution) of the qubit superconductors. The capacitance matrix is needed
to calculate EC and g, while the inductance matrix can be useful to simulate the magnetic
flux through the junction loop. In this work, the main focus was set on the simulation of EC

and g. Maxwell also calculates the electric (or magnetic) field at all points in the qubit model,
allowing a comparison of field strengths for different qubit designs in potential problem regions
for qubit relaxation. Furthermore, it is possible to define output variables as functions of both
the capacitance (or inductance) matrix and field operations. After the simulation has ended,
Maxwell will automatically calculate these output variables.

In order to create non-zero electric or magnetic fields in the qubit simulation, the user can
assign so-called excitations to conductors, including voltages and charges (for an electrostatic
solution) or currents (for a magnetostatic solution). In all electrostatic simulations, alternating
voltages of ±1 V were assigned to neighbouring superconductors (and 0 V to the ground plane)
so as to create field strengths which can be compared between different designs.

A very useful function of Maxwell for qubit optimization is the possibility to define pa-
rameters in the design, for instance the overall qubit length. Maxwell will then sweep this
parameter over a user-defined range in steps and solve Maxwell’s equations for every step. Out-
put variables can be stored in tables or plotted as a function of the sweep parameter, offering an
efficient way of optimizing the qubit parameters with respect to systematic structural variations.

Although Maxwell claims to be able to deal with objects of any shape, the algorithm for
creating the initial tetrahedral mesh would sometimes crash. This problem was mainly encoun-
tered while simulating objects with rectangular edges and corners (round shapes seemed less

12



qubit a) qubit b)
pass # tetr. EC/h g/h # tetr. EC/h g/h

1 2192 6 490 11253 11 3987
2 2854 3 229 14640 15 3809
3 3711 6 255 19036 22 3053
4 4830 10 283 24749 32 2239
5 6289 12 316 32191 53 1453
6 8190 26 334 41841 81 1047
7 10673 41 455 54407 120 688
8 13892 56 394 70775 164 529
9 18067 68 397 92000 203 476

10 23475 77 332 119634 237 451
11 30498 87 285 155450 260 423
12 39657 97 278 202016 281 401
13 51543 106 248 262659 294 388
14 66971 115 233 341182 305 378
15 87106 124 219 443180 313 370
16 113202 137 180 575917 319 365
17 147240 147 171
18 191426 158 163
19 248848 169 152
20 323537 177 147
21 420618 185 142
22 546894 193 140

Table 3.1: Convergence of the simulation in Maxwell for the two qubit designs shown in Fig. 3.1. The
quantities EC/h and g/h are given in MHz. Note that the two quantities converge in opposite directions.

problematic) or objects of very different sizes. A reason for this could not be found, since the
problem sometimes occurred in a parametric design variation for a few values of the parameter,
while the simulation worked fine for other values, making the occurrence of the error seem ran-
dom. However, sometimes, the problem could be avoided by increasing the "aspect ratio" of the
tetrahedrals in the inital mesh settings (typically by a few orders of magnitude), allowing the
algorithm to create tetrahedra which deviate more strongly from equilateral tetrahedra than
allowed by the default settings.

3.1.1 Convergence of simulations

In table 3.1, the convergence of the quantities EC and g is shown with respect to the number
of iterations and the number of mesh tetrahedra. Since the qubit fabrication process is not
precisely reproducible, i.e. fabricating the identical qubit design several times will result in
qubits with slightly varying properties, it was found that the results are sufficiently converged
between 500 K and 1 M mesh tetrahedra.

3.1.2 Field integral

Although the cause of the dielectric surface loss is not clear, the electric field in the surface
was taken into account in the qubit optimization. In order to do so, the mean electric field
(absolute value) in a 5 nm thick surface layer of the substrate was calculated by integrating the
magnitude of the field over the surface layer and dividing by its volume. The extension of this
layer is illustrated in Fig. 3.1 as a gray shading.
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Figure 3.1: a) Approximate reproduction of the transmon design described by ref. [12], used as a starting
point for qubit optimization. The gray shaded rectangle indicates the region where the electric field
in the surface was calculated. b) Typical transmon design previously used in our group, similar to the
qubits described in e.g. ref. [11]. The Josephson junction is not shown, but the resonator (red), island
(dark blue), reservoir (light blue) and ground plane (green).
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Figure 3.2: Initial parametrized qubit design for optimization based on ref. [12]. The parameters
are labelled as: gap reservoir-ground (a), gap resonator-island (b), width of the qubit fingers (c), gap
island-reservoir (d) and qubit finger length (e).

3.2 Optimization of transmon parameters

As a starting point for the qubit optimization, the approximate design reported in ref. [12]
was used, as shown in Fig. 3.1. In an initial optimization attempt, a number of parameters
were introduced: the length of the qubit fingers, their (horizontal) width and the gaps between
island-resonator, reservoir-ground and island-reservoir. The (vertical) thickness of the qubit was
always kept at 75 nm. Additionally, all corners were replaced by round shapes, since corners
locally produce high electric field strengths. The initial parametrized design is shown in Fig. 3.2,
with all the parameters indicated.

The main findings of varying these parameters (the results are not shown here, but the sim-
ulation files can be found in ”Q:\USERS\SimonBur\Maxwell\parameter variations new design\”)
are:

- Using as many fingers as in the design from ref. [12] combined with a large qubit size increases
CΣ too much, resulting in values for both EC and g which are clearly below the desired range.

- Decreasing the finger length enormously increases Ec and considerably increases g.
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- Small gaps between resonator-island and reservoir-ground strongly increase g, while consid-
erably decreasing EC .

- Increasing the gap between the island and the reservoir increases EC and moderately increases
g.

- Large gaps decrease the electric field strength in the surface of the substrate.

- Increasing the width of the fingers slightly decreases the electric field in the surface. Ec and
g are influenced due to the change in the overall qubit size.

Some of these changes in EC ∝ 1/CΣ can easily be explained by looking at Eq. (2.15): Increasing
the capacitance between the island and the reservoir C23 (i.e. larger qubit size, longer fingers,
smaller gap) decreases EC .
Some of the changes in g ∝ β can also be explained by looking at Eq. (2.17),

β =
C12C34 − C13C24

(C12 + C24)(C13 + C34) + (C12 + C13 + C24 + C34)(C23 + CJ)
:

β is increased if the couplings between island-resonator (C34) and reservoir-ground (C12) are
increased, while the couplings between island-ground (C13) and reservoir-resonator (C24) should
be decreased, since they contribute to β with a negative sign.

From these considerations, it seemed promising to create new qubits with a large overall
size, fewer fingers and an increased gap between the island and the reservoir. The gaps between
island-resonator and reservoir-ground form a compromise between a large coupling strength g
and small electric fields in the surface of the substrate.

3.3 Intermediate transmon design

For the new final qubit design of this semester project, a new mask for qubit fabrication had
to be designed and ordered externally. Until the new mask was received, new qubits for an
existing mask were designed, based on previous qubits, as shown in Fig. 3.3. These qubits were
designed to increase the coupling g to the desired range by decreasing the gaps island-resonator
and reservoir-ground to 1 µm (as it was in the old qubit designs), i.e. without taking much
compromise regarding the electric field in the surface (previous qubits in Fig. 3.3: 4.5− 6 µm).
The resulting qubits had similar relaxation times as the previous ones (on the order of 4 µs),
but with increased g. A summary of the qubit properties is given in table A.1.

3.4 Final transmon design

Based on results from numerous simulations, it was decided to design the new mask with cut-
outs for the qubits in sizes of 350×150 µm (one resonator) and 300×150 µm (two resonators), as
can be seen in Fig. 3.4. The optimization of the qubit coupling to one resonator is shown as an
example in Fig. B.1. An initial parametrized design was created, which seemed promising based
on previous simulations. All parameters were then swept across an individual range (restricted
by the mask and some of the other parameters). Because the previous (intermediate) qubits
with small gaps between island-resonator and reservoir-ground did not increase T1 as much
as we were hoping for, it was decided to increase these gaps again to 4 µm, at the cost of
considerably reducing the coupling strength g, as can be seen in Fig. B.1. In order to slightly
compensate for this, an additional extra finger was added to the reservoir, increasing β by an
increase in C12. The final qubit design, for both qubits coupled to one and two resonators, is
shown in Fig. 3.4.

15



a) b)

300 µm

60
 µ

m

300 µm

60
 µ

m

c) d)

60
 µ

m

60 µm

200 µm

20
0 

µ
m

60
 µ

m

60 µm

200 µm

20
0 

µ
m

Figure 3.3: Previous qubits, coupled to one resonator (a) and two resonators (c). The split junction
is shown here. The charge and flux lines for qubit control are colored brown. Note that for the qubit
coupled to two resonators, the flux line is integrated into the ground plane and the seemingly split
vertical resonator is connected by a conducting bridge. The new qubits with the previous mask, coupled
to one resonator (b) and two resonators (d), were designed to increase g to the desired range.
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Figure 3.4: Final transmon design of this semester project: a) qubit coupled to one resonator. The
additional finger at the right end of the reservoir was added to increase g. b) qubit coupled to two
resonators, with a cosine-shaped gap between the island and the reservoir.
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Figure 3.5: Circuit diagram of the simple model for dissipation due to capacitive coupling (Cgc) to the
charge line with a resistance of 50 Ω.

3.5 Comparison of the surface electric field

Despite the lack of a real model for the dielectric loss in the surface of the substrate, the mean
electric field in a 5 nm thick surface layer of the substrate was calculated. The results are given
in table A.1 for all the qubits mentioned in this report. Plots of a few qubits are shown in
Fig. B.2, showing an obvious decrease in the mean electric field strength from the old qubit to
the new design. In particular, regions of maximum field strength are strongly reduced.

3.6 Simple estimate of T1 due to coupling to the charge line

The charge line has a finite resistance which is assumed to be 50 Ω. Since the transmon is
coupled to the charge line via an effective charge line gate capacitance Cgc, dissipation in the
charge line contributes to decoherence in the qubit. A simple estimate for the relaxation time
due to dissipation in the charge line can be obtained by a classical model following ref. [2],
section III E. The transmon circuit can be modelled as an LC-oscillator coupled capacitively to
a dissipative element R = 50 Ω, as shown in Fig. 3.5, with C ≈ CΣ and L ≈ ~2/4e2EJ . The
LC-circuit has a classically oscillating charge Q(t) = Q0 cos(ωt) with the oscillator frequency
ω = q/

√
LCΣ. The energy stored in the oscillator is assumed to be on the order of one energy

quantum ~ω with Q0 =
√

2CΣ~ω. Cgc is calculated the same way as Cg for resonators. The
voltage across the transmon is given as

V (t) =
1

CΣ
Q(t) = V0 cos(ωt) (3.1)

with V0 =
√

2~ω/CΣ. The voltage on the island or the reservoir relative to the ground therefore
is V (t)/2. By using complex notation, i.e. V (t) = V0e

iωt, the voltage drop across the impedance
R can be calculated from

<(VR(t)) = <

(
R

R+ 1
iωCg

1

2
V (t)

)
=

RV0Cgω

2
√
R2C2

gω
2 + 1

cos(ωt) =: V 0
R cos(ωt).

With the average power dissipation given as

P =
1

2R

(
V 0
R

)2
,

T1 can be estimated as

T1 ≈
~ω
P
.
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Figure 3.6: Left: schematic network of the coupling between the split junction and the flux line. Right:
circuit diagram of the 20 dB attenuator. For Z0 = 50 Ω, R1 = 40.9 Ω and R2 = 10.1 Ω are obtained using
the online attenuator calculator at http://www.microwaves101.com/encyclopedia/calcattenuator.cfm

qubit φ (experiment) φ (simulation)
intermediate mask, old qubit (1 res., Fig. 3.3) 0.1 0.12
intermediate mask, old qubit (2 res., Fig. 3.3) 0.4 0.59
new mask, new qubit (1 res, Fig. 3.4 0.65 0.76
new mask, new qubit (2 res, Fig. 3.4 0.55, 0.77 0.79

Table 3.2: Measured and simulated magnetic flux through the split junction loop in units of φ0/V
for different qubits. For the new qubit coupled to two resonators, experimental data of two qubits is
available.

The resulting estimate for T1 was 33 µs for the final design with the new mask coupled to one
resonator, see table C.1. Therefore, T1 should not be limited by dissipation in the charge line.

3.7 Simulation of the magnetic flux through the split junction

The magnetostatic solver of Maxwell can calculate the mutual inductance between conducting
loops. This was used to simulate the flux φ through the split junction due to a current in the
flux line. Since Maxwell can only simulate classical behaviour, it can’t treat superconductors
magnetostatically (they are ignored in the simulation). To replace the superconductors in the
simulation, a new material was defined with properties close to a superconductor. The elec-
tric conductivity was set to 1028 S/m (default for superconductors: 1030 S/m) and the relative
magnetic permeability to 10−10.

The network is shown in Fig. 3.6. Using the mutual inductance M simulated in Maxwell,
the magnetic flux φ through the junction per voltage V in units of φ0 can be calculated. Some
results are shown in table 3.2. The agreement is not perfect, but a reasonable estimate of the
flux through the junction can be obtained from the simulation.
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4 Conclusion and outlook

The coherence time of our qubits has been improved by a factor of 3-4 by increasing the overall
size and modifying the shape of the qubits. However, the increase was smaller than what we
initially hoped for, the coherence time reported in ref. [12] could not be achieved. It is currently
unclear what the limiting factor for the relaxation time of qubits is. One possibility to further
increase the coherence might be an optimization of the qubit production recipe, because optical
microscope images of some recently produced qubits showed irregular patterns in the colour of
the qubit metal, possibly indicating resist residuals below the qubit metal layer.

Furthermore, a new formula for the coupling strength g was derived. The simulation results
obtained using the new formula are in good agreement with experimental data.

Finally, some experience in modelling qubits in Ansoft Maxwell 14 was obtained, which may
be useful for future simulations of related problems.
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A Additional tables

qubit measurement simulation

EC νres1 νres2 g1 g2 T1/µs ref. # tetr. EC νres1 νres2 g1 g2 〈|E|〉/Vm−1

old transmon, Fig. 3.1 b) 307 8625 - 340 - 1.1 [13] 748193 323 8625 - 338 - 4.7E+05
intermediate mask, Fig. 3.3 a) 282 7585 - 137 - 4.1 [13] 720963 329 7585 - 151 - 2.7E+05
intermediate mask, Fig. 3.3 c) 251 7585 10070 60 97 4.0 [13] 669690 302 7585 10070 76 106 3.9E+05
intermediate mask, Fig. 3.3 b) 331 8516 - 334 - . 4.5 [13] 742440 331 8516 - 360 - 2.8E+05
intermediate mask, Fig. 3.3 d) 295 8516 n.a. 318 n.a. n.a. [13] 912755 363 8516 9500 180 224 2.2E+05
qubit from ref. [12] 200 7325 - 130 - 9.7 [12] 710991 199 7325 - 121 - 1.9E+05
new mask final design, Fig. 3.4 a) 300 7700 - 260 - ≤ 2.9 [14] 914329 327 7700 - 268 - 9.3E+04
new mask final design, Fig. 3.4 b) 331 8700 9700 n.a. 240 ≤ 4.4 [14] 910967 346 8700 9700 204 232 7.8E+04

Table A.1: List of the properties of different qubits: experimental (where available) and simulated values of EC , g1 and g2, measured relaxation times T1

(where available) and the calculated mean field 〈|E|〉 in the surface of the substrate. All energies (EC , g) and frequencies (νres) are given in MHz. All
experimental T1 were measured at a drive frequency of approximately 5 GHz.
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B Additional figures
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Figure B.1: Example of qubit design optimization by varying geometrical parameters. The plots show
the dependence of EC , g and the mean electric field in the 5 nm surface layer on the design parameters.
For the final qubit design, the parameters were chosen as: a = 12 µm, b = 4 µm, c = 14 µm, d = 19 µm
and e = 45 µm. The resulting qubit is shown in Fig. 3.4, where an additional finger was added to
increase g.
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a) b)

c) d)

e) f)

Figure B.2: Plots of the electric field strength on the surface of the substrate for different qubit designs,
created with Maxwell. In the right column, close-ups of the qubits in the left column are shown. Top
to bottom: old qubit design used in ref. [11] ((a), (b)), qubit reported by ref. [12] ((c), (d)), new qubit
design ((e), (f)). Note that the field strength is plotted on the same (logarithmic) scale for all qubits,
showing a significant decrease in the mean field strength and a particular reduction of regions with very
high field strength.
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C List of simulation files

The Maxwell simulation files of all qubit designs referred to in this report can be found in the folder ”Q:\USERS\SimonBur\Maxwell\” (where Q:\
is the ”\\windata.ethz.ch\qudev” folder). The solutions are not contained in this folder, because large mesh files require a lot of disk space (all
calculations that were made consumed more than 100 GB in total). If solutions are needed, rerunning a single simulation should not take more
than 2− 3 hours for a parametric design, and less than one hour for a single geometry. A list of the file names used for the qubits described in
this report is given in table C.1.

qubit path (Q:\USERS\SimonBur\Maxwell\...)
typical old qubit, as used in ref. [11] standard transmon\finalM14Q1.mxwl
qubit reported in ref. [12] IBM_Chow12\IBM_Chow12.mxwl

previous qubits with intermediate mask (Fig. 3.3) Mask20_K1v6\Mask20_K1v6_lowerleft.mxwl (1 resonator)
Mask20_K1v6\Mask20_K1v6_upperleft.mxwl (2 resonators)

new qubits with intermediate mask (Fig. 3.3) old mask qubit 1\oldmask_qubit1_new.mxwl (1 resonator)
old mask qubit 2\oldmask_qubit2_final_produced.mxwl (2 resonators)

parametric optimization with new mask (Fig. B.1) Mask23\qb1\Mask23_qb1_sweep_*.mxwl

new qubits with new mask (Fig. 3.4) Mask23\qb1\Mask23_qb1_3.mxwl (1 resonator)
Mask23\qb2\wave\Mask23_qb2_wave_optimized.mxwl (2 resonators)

flux coupling simulations (table 3.2)

fluxline\Mask20_K1v6_lowerleft_fluxline.mxwl
fluxline\Mask20_K1v6_upperleft_fluxline.mxwl
fluxline\Mask23_qb1_3_fluxline.mxwl
fluxline\Mask23_qb2_wave_optimized_fluxline.mxwl

Table C.1: List of the file names used for the qubit simulation files. The path for all files starts with ”Q:\USERS\SimonBur\Maxwell\”.
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D Maxwell ”manual”

The purpose of this section is to give a short description on how to calculate the quantities used
in this semester project with Ansoft Maxwell 14.

D.1 General

When a newMaxwell file is opened, click Project > Insert Maxwell 3D Design. Before starting to
draw objects, it is recommended to choose the length unit of the drawing (Modeler > Units) and
specify the solution type (Maxwell 3D > Solution Type) to either Electrostatic for calculating
electric fields and the capacitance matrix or Magnetostatic for calculating magnetic fields and
the inductance matrix. Then all the objects can be drawn either by hand or imported from
CAD files (described below). At some point, a vacuum box surrounding all objects has to be
drawn, defining the problem region in which to solve Maxwell’s equations.

D.2 Import and export CAD drawings

Maxwell can import different CAD file types using Modeler > Import, including AutoCAD files
(.dwg and .dxf). However, files created in AutoCAD 2010 could not be imported directly to
Maxwell 14 due to incompatible file formats. As a workaround, .dxf files created with Auto-
CAD 2012 can be converted to GDSII files (.gds) using LinkCAD 5, which can be imported
into Maxwell.
When a 2D CAD drawing is imported, Maxwell creates 2-dimensional sheets. These can be
made 3-dimensional by selecting the objects and clicking Modeler > Surface > Thicken Sheet
and choosing the desired thickness.

Drawings created in Maxwell can easily be exported to .dxf files by clicking Modeler >
Export. This always worked fine, the exported files could be opened in AutoCAD 2012 without
problems.

D.3 Excitations, Matrix, Solution Setup

Maxwell needs at least one Excitation (boundary condition) assigned to an object to solve the
problem, otherwise, there is nothing to solve. The available excitations depend on the solu-
tion type. For the electrostatic solution, possible excitations include voltage, charge or charge
density. To define an excitation, right-click an object and choose Assign Excitation > ... .
Matrices such as the capacitance matrix can only be calculated for objects with excitations,
so an excitation must be assigned to every object of interest. Excitations can be zero, but
simulations normally converge better if some nonzero excitations are assigned. The capacitance
matrix does not depend on the value of the excitations, but fields do of course.

To define the capacitance matrix (after assigning excitations in the electrostatic solution
type), click Maxwell 3D > Parameters > Assign > Matrix, then check the objects which should
be included in the capacitance matrix.

Finally, a solution setup has to be defined. Click Maxwell 3D > Analysis Setup > Add
Solution Setup... . Choose a Maximum Number of Passes (to just check if the simulation works,
choose a small number) click ok, and the simulation can be started. After the simulation,
information about the mesh size, convergence and the capacitance matrix can be found in
Maxwell 3D > Results > Solution Data... .
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D.4 Output variables, field calculator, reports

Output variables are a useful tool to directly let Maxwell calculate functions of quantities like
capacitances or field operations. Output variables can be defined in Maxwell 3D > Results >
Output Variables.

The field calculator (Maxwell 3D > Fields > Calculator...) can perform operations on the
electric field of the solution, such as integrating the field over objects of the design. Integrals
can only be performed on objects which are modelled in the simulation, non-model objects
produce an error message. In the calculator, expressions can be saved and used in the definition
of output variables.

To create a report, click Maxwell 3D > Results > Create Electrostatic/Fields Report > ...
and choose the quantities which should be written in a table or plotted. The reports can be
found in Results in the Project Manager.

D.5 Design Parameters

To add a parameter to an object, first draw the object with some arbitrary size. Then double-
click the object (the command for creating the object, e.g. CreateBox for a box) in the history
tree to see the coordinates and dimensions of the object. Now, a variable can be added by
simply typing it into the coordinates or dimensions. A little window Add Variable will show up,
where the name (some names are protected), unit and value of the variable can be defined. Al-
ternatively, variables can be defined in Maxwell 3D > Design Properties (click Add...). Created
variables are listed and can be edited in Maxwell 3D > Design Properties. Note: the coordinates
and dimensions of objects can be defined as formulas containing both variables and constant
numbers. However, if variables and constant numbers are used, always add the correct units
to the numbers, e.g. ”1 um + a” instead of ”1 + a”. Otherwise, Maxwell will create a mess by
interpreting units wrongly, for instance ”1 + a” may be interpreted as ”1 m + a”, even if the
units of the drawing are specified as um (micrometers).

Design parameters can be animated, which can be very useful to check the drawing for errors
if a large number of objects are created with complicated dependence on several variables. To
do so, click View > Animate and choose the variable and the range for animation.

To get Maxwell to simulate the design for different values of some parameter, click Maxwell
3D > Optimetrics Analysis > Add Parametric.... Note that this will only work after the rest
of the simulation setup is finished. A window Setup Sweep Analysis will pop up. Click Add..
to add a sweep definition. Afterwards, the parameter variations are listed in the tab Table of
the Setup Sweep Analysis window. Go to the tab Options and check Save Fields and Mesh,
if you want Maxwell to evaluate expressions depending on field operations. If this box is left
unchecked, only the mesh and field of the reference design (the value of the parameter listed
in Maxwell 3D > Design Properties) will be saved. This also means that if you want to in-
crease the accuracy of the results by increasing the number of passes after a first completion
of the simulation, the simulation for each value of the parameter except the reference design
will restart from the beginning. So this box should always be checked, unless hard disk space
is strongly limited.

Output variables can be written in tables or plotted as a function of the sweep parameter
by clicking Maxwell 3D > Results > Create ... Report > Rectangular Plot / Data Table and
choosing the parameter as Primary Sweep.
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D.6 Magnetostatic solution

To calculate the inductance matrix, currents have to be assigned to the objects of interest, which
should be closed conducting loops, otherwise, the simulation may sometimes stop and produce
an error message. However, the current excitation can only be assigned to 2-dimensional sur-
faces (the current is defined to be perpendicular to the surface), therefore, to assign a current
to a 3-dimensional object (such as the flux line), the current excitation has to be defined on a
2-dimensional sheet which is placed inside the conductor. This can be achieved by intersecting
the conductor with a rectangle. To do so, click Modeler > Grid Plane > ... and select the
plane which is perpendicular to the current at the position where the current excitation shall be
defined. Draw a rectangle (Draw > Rectangle) which intersects the entire cross section of the
conductor. Copy the conductor, select the sheet and the copied conductor and click Modeler >
Boolean > Intersect. The current excitation can now be assigned to the resulting intersection of
the conductor and the sheet (Maxwell 3D > Excitations > Assign > Current). The direction of
the current and its magnitude can be chosen (choose a nonzero current for better convergence).

Once a current excitation is defined on all objects of interest, the inductance matrix can
be defined in the same way as the capacitance matrix (Maxwell 3D > Parameters > Assign >
Matrix ). The rest (solution setup) is the same as described above.
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